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Abstract - The most common structural defect is the 
existence of a crack. Cracks are present in structures due to 
various reasons. The presence of a crack could not only 
cause a local variation in the stiffness but it could affect the 
mechanical behavior of the entire structure to a considerable 
extent. Cracks may be caused by fatigue under service 
conditions as a result of the limited fatigue strength. They 
may also occur due to mechanical defects. Another group of 
cracks are initiated during the manufacturing processes. 
Generally they are small in sizes. Such small cracks are 
known to propagate due to fluctuating stress conditions. If 
these propagating cracks remain undetected and reach their 
critical size, then a sudden structural failure may occur. 
Hence it is possible to use natural frequency measurements 
to detect cracks. 
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I. INTRODUCTION 

Now-a-days the plants as well as industries are running 
round the clock to achieve the industrial goal. During 
operation, all structures are subjected to degenerative 
effects that may cause initiation of structural defects such as 
cracks which, as time progresses, lead to the catastrophic 
failure or breakdown of the structure. The inspection for 
quality assurance of manufactured products is thus very 
much important. To avoid the unexpected or sudden failure, 
earlier crack detection is essential. Taking this ideology into 
consideration crack detection is one of the most important 
domains for many researchers. The most common structural 
defect is the existence of a crack in machine member. The 
presence of a crack could not only cause a local variation in 
the stiffness but it could affect the mechanical behavior of 
the entire structure to a considerable extent. 

II. CRACK THEORY 

2.1 Physical parameters affecting Dynamic 
characteristics of cracked structures: 

Usually the physical dimensions, boundary conditions, the 
material properties of the structure play important role for 
the determination of its dynamic response. Their vibrations 
cause changes in dynamic characteristics of structures. In 
addition to this presence of a crack in structures modifies its 
dynamic behavior. The following aspects of the crack greatly 
influence the dynamic response of the structure. 

 The position of crack 

 The depth of crack 

 The orientation of crack 

2.2 Classification of cracks 

On the basis of geometry, cracks can be broadly classified 
into: 

2.2.1 Transverse cracks 

These cracks are perpendicular to the beam axis. Due to 
transverse cracks the cross-section of the structure got 
reduced and thus weakens the beam. Due to the reduction in 
the cross-section it introduces a local flexibility in the 
stiffness of the beam due to strain energy concentration in 
the vicinity of the crack tip. 

2.2.2 Longitudinal cracks 

These cracks are parallel to the beam axis. It is dangerous 
when tensile load is applied at right angles to the crack 
direction i.e. perpendicular to beam axis or perpendicular to 
crack. 

2.2.3 Slant cracks 

These cracks are at an angle to the beam axis. It influences 
the torsional behavior of the beam. Their effect on lateral 
vibrations is less than that of transverse cracks of 
comparable severity. 

2.2.4 Breathing cracks 

These are the cracks that open when the affected part of the 
material is subjected to tensile stresses and close when the 
stress is reversed. When under tension the stiffness of the 
component is most influenced. A crack breathes when crack 
sizes are small, running speeds are low and radial forces are 
large.  

2.2.5 Gaping cracks 

These cracks always remain open. They are more accurately 
known as notches. 

2.2.6 Surface cracks 

These are the cracks that open on the surface. These can be 
easily detected by dye-penetrations or visual inspection. 
Surface cracks have a greater effect than subsurface cracks 
on the vibration behavior of shafts. 
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2.2.7 Subsurface cracks  

These are the cracks that are not on the surface. Special 
techniques such as ultrasonic, magnetic particle, 
radiography or shaft voltage drop are needed to detect hem. 

3.3 Modes of Fracture - The three basic types of loading 
that a crack experiences are  

3.3.1 Mode I  

Corresponds to the opening mode in which the crack faces 
separates in a direction normal to the plane of the crack and 
the corresponding displacements of crack walls are 
symmetric with respect to the crack front. Loading is normal 
to the crack plane, and tends to open the crack. Mode I is 
generally considered the most dangerous loading situation.  
This mode is called as opening mode. 

3.3.2 Mode II  

Corresponds to in-plane shear loading and tends to slide one 
crack face with respect to the other (shearing mode). The 
stress is parallel to the crack growth direction and 
perpendicular to crack front. This mode is called as sliding 
mode. 

3.3.3 Mode III  

Corresponds to out-of-plane shear or tearing in which the 
crack faces are sheared parallel to the crack front. Shear 
stress acting parallel to plane of crack and parallel to crack 
front.  This mode is called as tearing mode. 

The following Figure 1 shows the three cracking modes of 
body. 

 

Figure 1 Three Cracking Modes of Body 

III. Design Consideration 

The cantilever beam with a transverse edge crack is clamped 
at left end, free at right end and has same cross section and 
same length like model in Figure 2.1. The Euler- Bernoulli 
beam model is assumed for the theoretical formulation. The 
crack in this particular case is assumed to be an open surface 
crack and the damping is not being considered in this theory. 
The beam under consideration extends from x = 0 to x = L 
and has a bending rigidity E I, which may be a function of x. 
The free bending vibration of a beam of a constant 

rectangular cross section having length l, width b, and depth 
h is given by the Euler’s beam theory. If the cross sectional 
dimensions of beam are small compared to its length, the 
system is known as Euler-Bernoulli beam. Only thin beams 
are treated in it. The differential equation for transverse 
vibration of thin uniform beam is obtained with the help of 
strength of materials. The beam has cross section area A, 
flexural rigidity EI and density of material ρ. The following 
figure 2.1 shows that cantilever beam. 

 

Figure 2.1 Cantilever Beam 

The following figure 2.2 shows that cantilever beam with 
crack. 

 
Figure 2.2 Cantilever Beam with crack 

The following Figure 2.3 shows that, representation of 
open edged inclined crack in cantilever beam. 

 
2.3 Representation of open edged inclined crack in 

cantilever beam. 

The continuous model of the beam has been discretized 
for simplification. According to Ranjan K. Behera, Anish 
Pandey, Dayal R. Parhi[11] for inclined edge crack 
cantilever beams, 
 
the difference in the two extreme locations is less than 4% 



          International Research Journal of Engineering and Technology (IRJET)       e-ISSN: 2395-0056 
                Volume: 07 Issue: 01 | Jan 2020                  www.irjet.net                                                                      p-ISSN: 2395-0072 
 

© 2020, IRJET       |       Impact Factor value: 7.34       |       ISO 9001:2008 Certified Journal       |     Page 150 
 

of the beam length. The relative crack position range 0.1 ≤ 
c ≤ 0.75 from fixed end and relative edged crack depth 
range 0.1 ≤ e ≤ 0.5 are tested. 

The following assumptions hold well as long as behaves in 
linear elastic manner. 

 Perfect bonding exists between fibres and 
matrix. 

 Both fibres and matrix are isotropic and obey 
Hooke’s law. 

 The matrix is free of voids or micro cracks and 
initially in a stress-free state. 

 The applied loads are either parallel or 
perpendicular to the laminate. 

 The laminate thickness is very small compared 
to its other dimensions. 

 Fibres are randomly distributed throughout. 

A reference [4] or an equation (3) designation 

IV.FINITE ELEMENT ANALYSIS 

FEA helps us to obtain new designs to meet the changing 
conditions in order to avoid material failure. FEA uses a lot 
of algorithms for its functioning. 2-D and 3-D model analysis 
are done by FEA in industry. 

4.1 Types of analysis done by FEA 

I. Structural Analysis 

Both linear and non-linear model comes under it. In case of 
linear models simple parameters are used and it is assumed 
that the material cannot plastically deformed. In case of non-
linear models the material is stressed beyond its elastic 
properties for which the stress in the material vary with the 
amount of deformation. 

II. Vibrational Analysis 

In this the material is tested for shock, impact and 
continuous and sudden vibrations. These situations affect 
the natural frequency of the structures and which may cause 
resonance and subsequent failure. 

III. Fatigue Analysis 

It helps to predict the life cycle of a material by having cyclic 
loading on the material. It helps to know the areas more 
prone to propagation of cracks. 

IV. Heat Transfer Analysis 

It helps to predict the thermal conductivity or fluid dynamics 
of the material. 

 

4.2 Role of FEA 

FEA helps the designer know all the theoretical stresses 
within the structure by showing all the problem areas in 
detail and thus helping the designer to predict the failure of 
the structure. It is an economic method of determining the 
causes of failure and the way the failures can be avoided. 

4.3 Modal Analysis: 

The modal analysis is used to determine the vibration 
characteristics (natural frequencies and mode shapes) of the 
structures or machine component while it is being designed. 
It also can be starting point for another, more detailed, 
dynamic analysis, a harmonic response analysis, or a 
spectrum analysis. 

The modal analysis used to determine the natural 
frequencies and mode shapes of structures. The natural 
frequencies and mode shapes are important parameters in 
the design of structures for dynamic loading conditions. 
They are also required if you want to do spectrum analysis 
or a mode superposition harmonic or transient analysis. We 
can do the modal analysis on pre-stressed structures such as 
spinning turbine blade. Another useful feature is modal 
cyclic symmetry, which allows reviewing the mode shapes of 
cyclically symmetric structure by modeling just a sector of it. 
Modal analysis in the ANSYS family of products is a linear 
analysis. Any non linearity, such as plasticity and contact 
(gap) elements, are ignored even if they are defined. 

Following steps show the guidelines for carrying out Modal 
analysis. 

a)  Startup: This path is followed and modal analysis 
workbench is started, as shown in Figure 3. 

 ANSYS > workbench > modal  

 

Figure 3 Startup Path 

b) Engineering data: The engineering data refers to the 
physical properties of the material. The new material named 
E-Glass Epoxy is entered and selected as ‘the default material 
for object’. 

c) The isotropic density is entered as 2000 kg/m3. Poisson’s 
ratio = 0.30, young’s modulus of elasticity = 39 GPa.  
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Table 6.1 Material Properties 

Sr. No. Property Value Unit 

1 Mass 
Density (ρ) 2000 Kg/m3 

2 Young’s 
Modulus (E) 39×10 3 N/mm2 

3 Poisson’s 
Ratio () 0.30 _ 

 
d) Save: Save the file in the preferred location. 

 Save > File name 

e) Geometry: The required cantilever beam is designed in 
catia and saved with the extension of ‘.igs’ and then imported 
to ANSYS, as shown in Figure 3.2. 

Geometry > Import geometry> .igs file > Open  

 

f) Modal:  

 Mesh The mesh is used to divide the element into 
number of parts. Fine mesh is generated in this 
problem which increases the accuracy. 

Mesh >Mesh setting > Fine mesh  

Mesh >Right click > Generate mesh 

 Support The fixed support is provided at the end of 
beam to transform the beam to cantilever. 

Select the surface to be Fixed > Insert > Support 
>Fixed support.  

 Number of modes in this case four number of 
modes are selected. 

Analysis setting > Number of modes > 3. 

g) Solution: After entering above settings the solution is 
being solved for modal results. Figure 3.3 shows that 
solution of model. 

 
Figure 3.3 Solution of Model 

 Generating the model in designing software: 

The designing software used here is CATIA VR19. The model 
of the beam having crack is generated in Catia software with 
different crack location, crack depth and various crack 
inclination. Figure 6.4 shows that cantilever beam in CATIA 
V5R19. 

 

Figure 3.4 Cantilever beam in CATIA V5R19 

Figure 3.5 shows that model having crack in CATIA V5R19. 

 

Figure 3.5 Model having crack in CATIA V5R19 
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Figure 3.6 shows that side view of crack. 

 

Figure 3.6 Side view of crack 

Figure 3.7 shows that magnified view of crack. 

 

Figure 3.7 Magnified View of crack 

Figure 3.8 shows that mesh modal of beam. 

 

The modal becomes as follows 

The first three natural frequencies and corresponding mode 
shapes are calculated by FEA using ANSYS workbench 14.5. 
Figure 3.9 shows that first Mode shape of uncracked beam. 

 

Figure 3.9 First Mode shape of uncracked beam 

 

Figure 3.10 shows that second mode shape of uncracked 
beam. 

 
Figure 3.10 Second Mode shape of uncracked beam 

 Figure 3.11 shows that third mode shape of uncracked 
beam.   

 
Figure 3.11 Third Mode shape of uncracked beam 

Figure 3.12 shows that first Mode shape of cracked beam 
with c=0.25, e=0.30, θ=150   

   
Figure 3.12 First Mode shape of cracked beam with c=0.25, 

e=0.30, θ=150 

Figure 3.13 shows that second Mode shape of cracked 
beam with c=0.25, e=0.30, θ=150 

 
Figure 3.13 Second Mode shape of cracked beam with 

c=0.25, e=0.30, θ=150 
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Figure 3.14 shows that third mode shape of cracked beam 
with c=0.25, e=0.30, θ=150. 

 

Figure 3.14 Third Mode shape of cracked beam with 
c=0.25, e=0.30, θ=150 

Figure 3.15 shows that first mode shape of cracked beam 
with c=0.35, e=0.30, θ=300. 

 

Figure 3.15 First Mode shape of cracked beam with c=0.35, 
e=0.30, θ=300 

Figure 3.16 shows that second Mode shape of cracked 
beam with c=0.35, e=0.30, θ=300.      

 

Figure 3.16 Second Mode shape of cracked beam with 
c=0.35, e=0.30, θ=300 

Figure 3.17 shows that third mode shape of cracked beam 
with c=0.35, e=0.30, θ=300. 

 

Figure 3.17 Third Mode shape of cracked beam with 
c=0.35, e=0.30, θ=300 

Figure 3.18 shows that first mode shape of cracked beam 
with c=0.20, e=0.10, θ=450. 

 

Figure 3.18 First Mode shape of cracked beam with c=0.20, 
e=0.10, θ=450 

V. Conclusions 

 It is found that if crack location and crack 
inclination is constant then crack depth is increases 
natural frequency is decreases. 

 If crack depth and crack inclination is constant then 
crack location is increases natural frequency is 
increases. 

 Crack is near to fixed end it imparts more reduction 
in natural frequency. 

 The present study provides an efficient non 
destructive technique for the detection and 
prediction of the current size and position of the 
crack for any composite structure system. 
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